Basic

Computing
For those wanting a basic knowledge of computers
Basic Computing
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The Mouse

The mouse is the key tool to master when you start to learn the basics of computer use.  Keyboard use will come with time – yes you may be slow to begin with but you will become faster with practice.  

Take the mouse in your hand and move it around.  You will see an arrow move on the computer monitor - this called the mouse pointer.  Also you will notice that a mouse has two main buttons. The left button is the one we will use first. It is also the button we use the most. Any item that is underneath the mouse pointer can be activated by clicking (or double clicking) this left mouse button.

The Desktop
The first main screen in Windows you see on the computer monitor after you start it up is called the Desktop. Study the picture on the next page and become familiar with the items on it.
Windows XP Desktop
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Tasks (do these!):

(1) Shut Down Computer

To turn off the computer you don’t just press the power button!  The proper procedure is as follows:
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Move the mouse pointer to the “Start” button and click on it with the left button. 

· Now move the pointer to “Shut Down” and click again.

· Ensure  ”Shut down” is selected on the box that appears (as seen here) and click the “OK” button.

· The computer will now shut itself down and turn itself off!

(2) Start Computer
Press the power button on the computer – ask your teacher to show you this if you can’t find it yourself (they very in location from computer to computer).

The computer will power up, a number of different screens will flick by, simply wait until the Desktop is fully loaded before doing anything else.

Repeat these tasks until familiar with them.
Programs
Programs allow one to perform the wide range of tasks that can be done on a computer.  All installed programs can be accessed by clicking on the “Start” button, moving your mouse pointer to “All Programs” (You don’t have to click here!), and then moving your mouse up to the program you wish to run. Once you have your mouse over the program, you need to click on it to make it run. All programs open in what is called a “Window” and all “Windows” have common components which we will explore.  
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Task:
Follow the instructions above to locate and run “Spider Solitaire”.
You will find it in the programs list under “Games”. Ask for assistance if you don’t know how to play it.   Playing this game will increase your mouse skills.
Standard Window Features
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Menus
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Note that there are some words in the top left hand corner of the screen in Spider Solitaire – clicking on these will open a Menu of functions that can be activated by clicking on the one desired.
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Click on “Game” than go down to “Show an available Move” and click on it to see how this works.  Explore other functions under these Menus.  Don’t be afraid to try!
Control Buttons
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In the top right hand corner of the of Spider Solitaire window you will see the “Control Buttons”.  The appearance of the middle one may vary depending of the state the window is in 
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Tasks: 

Try clicking the middle button and then clicking it a second time – note the two states the window can be in and how the button changes.
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Click the left one (-) to Minimise the window – you will have to click the program on the Task Bar to restore it again. 
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Click on the right button (X) to close the program.
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Window Resizing

When a window isn’t full screen (Maximised) it can be resized and reshaped by moving the mouse to the bottom, left or right edge (or either bottom corner), the mouse pointer will change here into a double ended arrow.  Clicking and dragging (hold the mouse button down while moving the mouse) when the mouse is pointer is like this will move the window edge.
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Task:

Open two windows – My Documents and My Computer (You will need to double-click if you open these from the desktop icons).  Resize and move these two windows so that they appear side by side on the computer desktop. Remember that clicking and dragging the Top Bar of a window when not maximised will allow you to move the window.
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Right Mouse Button

You may be wondering what the right hand mouse button it for and when you use it.  Try clicking it on an empty potion of the desktop!  A small Menu will appear.  This works the same as any other Menu – these functions may be accessed by clicking on the – with the left button!  The contents of the right-mouse Menu will vary according to where you right-click.  
Task:
Try different locations and note the differences.   Essentially the right mouse button provides fast access to the most commonly used functions

The Internet
The Internet is worldwide network of computers called “Web Servers” that can be accessed from any computer which has an account with an Internet Service Provider (ISP). Activates that can done on the internet are many and varied, the most common being browsing (often called “surfing”), email and direct messaging (sometimes called “chat”).

Two types of internet access are available: dial-up and broadband.  Dial-up requires a “modem” and means that your makes a phone call every time you wish to connect to the internet. A username and password is used to verify your identity and log you in to your account.  The call needs to be disconnected after the period of access is completed. Broadband is a much faster type of internet access that is always on – meaning no phone call is required.  Broadband takes many forms, the most common being ADSL.  Broadband is what we have here at Penguin Online Access Centre.
Browsing the Net

The software on the computer used to access the “net” or “web” is called a “Browser” – the most common of these is “Internet Explorer”.  This is the one we will be using here. There are many others – Firefox and Opera being two of the best.
Once connected to the internet websites are accessed by typing a web address into the Address Bar of a browser and then clicking the “Go” button or pressing the “Enter” key on the keyboard (easier).  A web address may be http://www.google.com, but when entering a web address you only need to type the www.google.com, the http:// will be entered automatically. You never need to type this!
Study the next page and remember the key areas of Internet Explorer. 

Internet Explorer
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Understanding a web address
An address such as http://www.education.tas.gov.au/ace is composed of a number of sections – starting form the left:

http:// 
This stands for the protocol used: HyperText Transfer Protocol. Remember you don’t need to type this part!

www


Refers to the World Wide Web. Not used in all addresses.

.education.tas
education is the “sub-domain” of tas which is the actual domain name for the network.  In simple terms, this is the “real” name of the website!

.gov
This means that it is a government site – there are a whole list of these identifiers, common ones being: com, org, net asn and gov.
.au
Country code for Australia.  All countries except the US have country codes! However just because a site doesn’t have a country code doesn’t mean it is a US site … confused? 

/ace
This is the name of a directory (folder) within the website.  Everything after the forward slash (/) can be removed to access the “home” page of the website.

If an address ends with .htm, .html, .asp or .php this must also be entered to access the specific page.  These are “file types” and are part of the particular page name.
Hyperlinks
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When you have accessed a webpage you will notice a number of words which may be blue and/or underlined.   When you move your mouse pointer over these it will change from an arrow to a hand with index finger extended.  This means that the text in question is a hyperlink.  You can click this with the left mouse button to jump to a new page because a web address is coded (hidden) into text you have your mouse over.  Hyperlinks may also be found in pictures on the webpage.  Always move you mouse around the page to see where the finger appears.

Tasks:
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(1) Open Internet Explorer.  Either go to the Start button and All Programs and locate it or double click on the Internet Explorer icon on the desktop.  Explore the menus in IE.
(2) Use the Penguin Online Access Centre homepage, open hyperlinks, use the scrollbar, use back and forward buttons.  Remember that clicking the “back” button will take you back to the last page you were at when you clicked the last hyperlink – one step back at a time. Ask for assistance if needed.
(3) Type “www.yahoo.com” into the address bar and activate it by clicking “Go” or pressing the “Enter” button on the keyboard. Explore the website.
[image: image79.png]Background:

B Ascent

8|

[BAmi Postior:
Stetch

S Baloon

Biowse,

e

Colr:

E—



Note that to type into the address bar you need to click once on the address that it there currently; when you do this the current address become highlighted with blue.   You can now beginning typing your new address and old one will be erased. 
 (4) Go to www.theadvocate.com.au. Locate a news article, go to the File menu and click on Print Preview, this will show you what it would look like on paper if you printed it.
Searching the Web
The Internet is a massive place with billions of pages. Finding the information you want can be difficult.  The best starting place in your search is a search engine. 
A search engine is simply an indexing service for the Internet.   There are many search engine available – some general, some specialized.  We will take a look at only two in this course, but you are free to explore others at your leisure. 

The primary search engine we will use is Google (www.google.com or www.google.com.au).  Google is simple to use and very quick.  It not only gives text based results, but can be also used to search for picture (images) and news.

Tasks:

(1) Enter www.google.com.au into the browser address bar and activate it.

It will load as follows:
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(2) Enter the word “Penguin”, choose “pages from Australia” and click

“Search Google”.  The result will be something like the one below, click on some of the results to visit the websites, than come back to Google.
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Now change your search to “Penguin Tasmania” and notice the different set of results.  The more specific your search wording is, the more accurate the results will be.

(4) Now click on “Images” and search for “Penguin”. Note that the result is a series of pictures.
(5) Try some searches of your own. Look for something that interests you. Note that you don’t need to include words like “and”, “in”, “at”, etc as these are far to common and will be disregarded by the search engine.
(6) Type www.whitepages.com.au into the address bar of your browser and activate it.  This will bring up the Telstra Whitepages.  Click “Residential” to switch to a residential search and search for yourself – or a friend. Click in each box BEFORE typing into it. Note that boxes with a “*” next to them MUST be filled out.
Click the little down arrows to access the list of states and to choose Metropolitan Area or Regional – anything other than Hobart in Tasmania is regional.
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A search for “Smith”, with initial “J” in Regional Tasmania will look something like this – 
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Email
Email is simply electronic mail that is sent from one computer to another.  It does however have a system of “Post Offices” – servers (computers) were mail can be collected.  Two forms of email access are used today: POP email is accessible by programs like Outlook Express or Outlook.  POP addresses are provided by your ISP (Internet Service Provider) and often are only accessible from your home computer.  Web based email addresses however are able to be accessed from any computer in the world with Internet access.  These are provided by companies such as Hotmail, Yahoo and Google.  These services are free, as they are paid for by advertising.  You may have as many of these email addresses as you wish…you don’t even have to use your own name!  Here at the Online Centre we can only use these Web based email addresses.
Spam

You may have heard of something called “Spam” that people get in their email.  It is simply un-requested email, similar to the junk mail you get in your letterbox!  The best defence against Spam is to be careful with you email address – don’t give it to anyone you don’t trust!  Don’t enter it into website forms…unless you know the site policy well and trust them!  Have another email address for this purpose if you need to do this.
The Email Address

An email address has one common feature, the “@ “ (at) symbol!  If an address has this in it you know it is an email address.  The @ breaks an email address into two parts.  The part before it is the username, the part after is the email server name (username@emailserver).  Penguin Online Centre has a username of “penguin” on the “tco.asn.au” server, so the address is: penguin@tco.asn.au.

Gmail

We will take you through the process of creating an email address using Gmail. This is Google’s email service, it provides massive mail storage with little invasive advertising.  Go http://gmail.com  and click the “Sign up for Gmail” link.  You will then need to fill out a form to create your address. Most fields are obvious.
Remember to record your email address and password.  Yes passwords need to be kept private, but it is good to write it down at this stage:

Email Address: ……………………………………………………………….

Password: …………………………………………………………………….
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James Smith
1 Main Rd
Penguin Tas 7316

Dear James,

Thark for offering to be a volunteer at the Penguin Orline Access Centre.
Our extended hours are orly possible because of ourvolunteer support. We
hope you wil be able to come in and meet other volunteers and have a chat

about what is involved on the 3 August at 10am.

Yours Sincerely

John Steed
Coordinator
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After creating your account, Gmail will take you to a couple of screens with information about your account, before actually taking you into your email.  You just need to click the “I’m ready - show me my account” buttons to get past these screens to your account which will look like the picture below.






Before exploring Gmail we will sign out and sign back in so that you go through the normal sign in process.  Click “Sign Out” and then CLOSE Internet Explorer.

Now we will go through the normal process you will use to access your Gmail account.

(1) Open Internet Explorer

(2) Type “gmail.com” into the address bar and activate it by clicking “Go”.

(3) The Gmail login screen will now appear.  Enter your Gmail username and password.  Your username being the part of your email address before the “@” symbol.
(4) Clicking “Sign in” will now log you in to your email account.  If you have any delays at this stage click “Refresh” on your browser toolbar.

Sending a new email.
The first task we explore is sending a new email.  An email has three main components: (1) a recipient email address; (2) a subject (a brief description of what the message is about; (3) the message itself.  Other optional components are “CC”,  “BCC” and “Attachments”. “CC” stands for “Carbon Copy” – putting an address in this field will send a copy to that person.  “BCC” is the same as “CC” except that the “B” stands for “Blind” – addresses in this field are not revealed to recipients.  Attachments are files of any kind (documents, photos, etc) you may wish to send along with your email.
Task:
Click the “Compose Mail” link in the top left hand corner of the Gmail page.  This will open the compose mail screen.  Send a message to Penguin Online Access Centre - penguin@tco.asn.au!




Experiment  - send emails to your friends/family or more to the Online Centre if you don’t have any addresses.

Messages you have sent will be accessible at any time in the future by clicking on “Sent Mail”. 
Attaching Files

Attaching files is a task many people find difficult, try these steps, but if you have any difficulty ask for assistance,

When composing a new message, click the “Attach a file” link.  
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This will open a small box below the Subject box – as below. 
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Now click the “Choose” button. This will open a another small window that will allow you to browse for and choose the file you wish to attach. Click the file you want to attach, than click the “Open” button
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After clicking the “Open” button, the file name will appear as below for a short time – while the file transfers.
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After the file has transferred to Gmail, it will change to look like the picture below.

[image: image14.png]Subject: |

& X Computer terminoloay for Aussies doc (anplication/msworc) 25k
Aitach another e





This file will now be sent with your email when you click the send button.

If you wish to attach another file, simply click “Attach another file”.
Receiving Attached Files

When you have received an email with an attached file, you will know this because you will see a small paper clip beside the incoming message.

Click on the message and open it.  At the very bottom of the email message you will find the attached file.  Click the “Download” link.

The “Download File” dialog box will now appear click the “Open” button if you simply want to look at the file, or the “Save” button if you wish to keep the file on your computer.  Note that as long as you keep this email message in your Gmail account, you will also have access to this file.
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Replying to an Email
Once you have opened an email message and read it you may wish to reply to the sender. Alternatively you may want to send it on to another person. To reply to the sender simply click the “Reply” link at the bottom of the message. 


Once you have done this a new section will open at the bottom of the screen where you can type a message back to them.  Once you have done so, click “Send” to send the reply off.





If you choose to forward the message to another person, you will need to enter an email address for that person in the “To” box.

Cleaning your Inbox
When you have finished reading and replying to your email you will want to clean your Inbox.  This means you must make decisions about the long term future of your messages!   The options are to Delete them forever, or Archive them (Store them forever!).  If in doubt it is best to archive, Gmail has virtually unlimited storage so you won’t run out of room!

When archiving you do have the option to mark messages with a Star so you can find the easier.

Always mark messages you want to apply an action to first.  This allows you to archive or delete multiple messages at once.





Sign Out
Remember when you have completed using your Gmail account that you need to sign out.  This is especially important on public access computers such as those at the Online Centre!  Once you have signed out you can close your browser…or go to another website.


File & Folder Management
A computer is capable of storing many types of information or “data”; this includes documents, pictures and video.  Each document, picture, etc is referred to as a ‘file”. How does one organise and access these?  First you need to understand the various areas of storage available on your computer. All data storage occurs on what is referred to as a “drive”.  If you open “My Computer” – either from the desktop or from the Start menu you will be able to see the various drives available on your computer.  This will include some of the following:

You may be wonder about the measurement of data at this stage.  In very basic terms, each “character” on a document is equivalent to 1 “byte” of data.  1024 Bytes = 1 Kilobyte (kb).  1024 Kilobytes = 1 Megabyte (mb).  1024 Megabytes = 1 Gigabyte (GB).  So again in very rough terms, 1 gigabyte is equal to 1 billion characters or 500,000 pages of typed text!
Folders
To better organise files, they are generally organised into “folders”, these are simply containers for file organisation, similar to a folder in a filing cabinet.

Double click on “C:” drive and you will see the standard icon for a folder – as with all icons, they also are opened by double clicking. 
The main storage area for documents that are created by computer users is a folder called “My Documents.”  The best practice is to store ALL files and folders you create in this folder.  My Documents can be accessed directly either from the Desktop or the Start menu.  Look for this icon: 
Task:
Open My Documents.  Using the “File” menu in the My Documents window, create a new folder.

The new folder will appear in the My Documents window with the name “New Folder” in blue.  When it is in this state you are able to type a name for your new folder immediately.  Type your own name and the press enter on your keyboard, the folder will now have your name. 
This folder can now be used to store all the documents you create during this course.  Open the folder you have created (double click) and create a new folder in it using the same procedure.  Name this new folder “Practise”.  We will use this folder to practise the file and folder deleting procedure.

To delete (remove) a file or folder one simply has to click the file or folder just once to select it (it will turn blue), and then press the “Delete” button on the keyboard.  The computer will then ask you to confirm this action.  Click “Yes” to send this file to the bin.  Do this with the folder you named “Practise.”

Note that when you delete a folder, you will also delete ALL files in it! So always check the contents of a folder before deleting it.

Word Processing
A word processor is a computer program used to create documents of any kind. You can use a word processor to create anything from a letter to book!  The word processor we will introduce to you in this course is Microsoft Word.

Microsoft Word can be opened either by locating its icon on the computer desktop (if there is one), or by going to the Start button >All Programs > Microsoft Office and then clicking on Microsoft Word 2003.  Older versions of Word may be located on All Programs.

Word will open with a new blank document, and look something like the next page. It is ready for you to enter text.  Simply type your letter - or whatever.  The text will wrap to the next line automatically when it reaches the edge of the page.  Press the “Enter” key on the keyboard when you want to move to a new paragraph.

Task 1:

Step 1 - Open a new Word document (if you haven’t already done so) and type the following letter.

1st July 2006

James Smith

1 Main Rd

Penguin Tas 7316

Dear James,

Thank for offering to be a volunteer at the Penguin Online Access Centre.  Our extended hours are only possible because of our volunteer support. We hope you will be able to come in and meet other volunteers and have a chat about what is involved on the 3rd August at 10am.  

Yours Sincerely


John Steed

Coordinator

Jump the next page to Step 2.
Microsoft Word
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Step 2 The first priority after typing a document is to save it in case of an accident!  Actually it is quite a good idea to this even while you are still typing the document.

To save this letter, click “File” on the menu bar, then click “Save As”.  Note: if the menu item you are looking for is not displayed, click the down arrows at the bottom to expand the menu list.
The “Save As” dialog box will now appear.  You need to ensure

 that you are in “My Documents”, then locate and double click the

folder that you created with your own name.



The “Save in” folder will now change to the one with your name, you then need to type a name for the letter you saving – we will call it “letter” – in the  “File name” box.  Than click “Save”.  The letter has name been saved in folder with your name, in My Documents, with the file name of “letter”.
Now close Word by clicking the close window control button.

Task 2:
Open Word again – it will open a new blank document, but we want to re-open the letter you just saved – so we need to click “File” then “Open” to enter the file open dialog box. It should open to the folder you just saved the letter in, if not, click the “My Documents” button and browse back to it. Open the file “letter”.


The document name will now display the name of the file you just open and the text you typed will be back on screen.
Important: You can now save any changes to this document by simply clicking the save button on the toolbar. 
The formatting toolbar
It’s important to be familiar with the buttons on the formatting toolbar as this is what you will use to change the appearance of your text.  You can find out what a button does simply by placing you mouse pointer over it and waiting for “tooltip” to appear.  




Selecting Text.
Before any formatting changes can be applied the text you wish to change needs to be selected.  There are two methods that can be used to select text:
Method 1: Click and hold the left mouse button at the beginning of the text you wish to select, than drag the mouse to the end of the text you want selected and release the mouse button.  The selected text should invert in colour (white text on black).

Method 2: Click the mouse once (and release) at the beginning of the text you wish to select.  Hold down the “Shift” key on the keyboard.  Click the mouse at the end of the text.  Than release “Shift.”  This method is probably easier and more accurate.

Once you have selected text, click the formatting buttons you wish to apply to it on the formatting toolbar (more than one type of formatting may be applied to selected text at once.)  

Remove the selection from the text by clicking just once anywhere in the white space on right hand side of the page.
Task 1:

Open the letter you created, select the date and address. Format as Bold, set the font to Arial and size to 10.    Deselect the text.
Hint: to select font and size, click the little down arrow, than locate font or size (scroll if required) and click on it.
Select the body of the letter from “Dear” through to “10am.” Set 
the font to “Papyrus”, size to 12 and alignment to “Justify”.  Deselect the text.


Select the remainder of the letter. Set the font to “Papyrus”, size to 12 and alignment to “Center”.  Deselect the text and save your document! (Remember you can just click on the “Save” button on the toolbar.)  It should now look like the letter below.


Task 2:
Select the whole letter – note that you can do this quickly by holding down the “CTRL” key on the keyboard and pressing the letter “A”. 

Change the colour of the text by clicking the down arrow beside the text colour button and clicking on a colour. Find a colour that looks right.  Deselect the text.

Save the document!

Editing Text.

Often you may wish to make changes to the text of document – add or delete words, correct mistakes, etc.  To do this you need to move the cursor – the flashing black line – into the location you need to make the changes.  You can move the cursor by either clicking into the location you want it to be, or by using the arrow buttons on the keyboard.  The arrow keys are good for small exact movements. 
To delete text you can use either one of two keys on the keyboard.  The “Backspace” key deletes text to the left of the cursor, while the “Delete” key deletes text to the right of the cursor. 

Task: 1 

Practise using these keys.  Change the name of the recipient of the letter from James to Robert.

Copy and Paste

One of the most useful functions in a computer is copy and paste.  Any text, picture, file or folder may be replicated in almost any location simply by selecting it, copying it, than moving to the desired location and pasting it.   The Copy function transfers the selected item to what is called the Clipboard; Paste inserts this item from the Clipboard into the desired location.  Once you have copied an item you are able to Paste it as many times as you wish. 

The Copy function is available from the Edit menu or the right-mouse menu when an item is selected – note that it will not be available if you haven’t selected anything!  

Paste also is on the Edit menu or the right-mouse menu.  It will only be available only when you have copied an item.  Note that Paste will always paste the most recently copied item.
Task:

Step 1: Open the file “letter” if it isn’t already open.  Select the text of the whole letter.  Go to the Edit menu and click Copy.   Close the file.

Step 2: Open Word with a new blank document.  Click on the blank document once.  Go to the Edit menu and Click paste.  The text of the letter will now appear in the blank document.  Save this new letter as “copy and paste”.
Practise this procedure a number of times in different situations, remember that you can copy and paste:

· Selected portions of text within the same document.

· Selected portions of text from one document to another.

· The entire body of a document (selected) to another document.

· Selected text from a webpage to any document.

· Selected pictures from a document or webpage to any document.
· Selected files from one folder to another folder.

· Selected folders from one location to another.

Inserting Pictures

Pictures and clip art may be added to Word documents and formatted to any desired size or alignment.  Clip Art is a selection of art work that is packaged with Word and other Microsoft Office components.  Clip Art insertion procedures are a little different in newer versions of Word to older versions of Word.  You can access both Clip Art and insert pictures that are saved on your computer from the Insert > Picture menu.
To insert a picture from file you need to have the picture somewhere on the computer you are using.  This could be in My Documents, on the computer Desktop, or it may be on a CD or USB Flash Drive (These would have to be in the computer.)

Note that pictures can also be inserted by using Copy and Paste if they are already in another document.
Task 1:

Open a new Word document. Click the Insert menu and go to Picture and across to From File.  Browse and locate a folder with pictures in (ask for assistance), once the picture is located click on it, than click Insert.
The picture will then 
appear on your document. 

Task 2:

Click the Insert menu again and go to Picture and across to Clip Art.  This will open the Clip Art pane on the right hand side of the screen.  This allows you to search for clip art.  Type the word “computer” into the “Search for:” box and click “Go.” 

Now place your mouse over one of the results and double click.  The selected clip art will now appear in your document.
Formatting a Picture

The procedure for resizing and positioning a picture is the same for both Clip Art and a Picture from file. 
Simply clicking once on a picture will highlight the picture with little black squares and bring up the Picture Toolbar somewhere on the screen.  Moving the mouse to one of these little black squares will change the cursor into a double ended arrow.  Clicking and dragging when this double ended arrow is visible will allow you to resize the picture – larger or smaller depending on which way you move the mouse.  It is always best to use the black squares in the corners as this keeps the picture in proportion. 
Task:

Practice resizing the pictures you have inserted. Close this document – don’t save!
While a picture is highlighted, explore the Picture Toolbar.  Running your mouse over the buttons will bring up the tooltips telling you what these buttons do. 

The normal setting is that a picture behaves as if it is text and its alignment can be changed by clicking the text alignment buttons.  But the button with the little “dog” on it – Text Wrapping – is most useful. Clicking on this and choosing the “Square” option will change the little black squares into circles.  When these circles are present you are able to click and drag the picture to any location on the document you desire!
Task 1:

Open the document “letter” you created previously.  Locate and insert some appropriate clip art.  Change it’s text wrapping to square and find an appropriate place to place it.  Save the document and close it.

Task 2:

Create a document of your own using what you have learned – add coloured and centred text and a picture.  You may copy and paste from a webpage, or type your text.  Save it in your folder with an appropriate file name when complete.


Printing documents
Before printing a document on paper it is a good idea to see what it will look like when it is printed.  Print Preview has been created for just this purpose.  It can be accessed by either going to the File menu and down to Print Preview.  Alternatively click the print preview button on the Toolbar.   This will open the Print Preview – a view of what your document will look like on paper.  If it looks right, click the “Print” button on the left side of the toolbar - this will immediately print your document on the main printer. 
If however you aren’t happy with it, click the “Close” button on the right hand side of the toolbar to return to the normal editing screen.


Task:


Open the “letter” document and print it using print preview.

The Recycle Bin
When you delete files or folders in Windows they aren’t completely removed immediately.  Rather they go a place called the Recycle Bin (accessed from the desktop); this allows you to retrieve the item if you have deleted it by mistake.  Once in awhile however it is good to go to the recycle bin and empty it – this deletes the files permanently. 

Recover a File
To recover a file or folder deleted by mistake - open the Recycle Bin on the desktop by double clicking it.  Locate the file you wish to recover (scroll down if necessary).  Click once on the file to select it, than go to the File menu and click on “Restore”.  The file will then return to its original location.
Empty the Bin

It is good to empty the Bin fairly regularly as file in the Bin still use Hard Drive space, and the more files in there the harder it is to find a file you may wish to recover.  To empty the Bin you first need to open it, then check the contents to ensure there is nothing in there that shouldn’t be – everything in the Bin is about to be deleted permanently!  Ensure that no files are selected then go to the File menu and click “Empty Recycle Bin.”  You will then be asked to confirm the file delete, click “Yes” and the Bin will empty.
Once the Bin has been emptied these files can only be recovered using special file recovery software – under the right conditions.

Task:

Locate and delete the file “letter” that you created.  Open the Recycle Bin and recover the file.
Shortcuts

Shortcuts are icons that you can click on to jump to the actual file which is located elsewhere.  Most shortcuts are located on the desktop as this is the most accessible area on the computer.  There are several ways to put a shortcut to a file or folder on the Desktop, but the fastest and easiest is to simply right click on the file or folder and move the mouse down to the “Send to” item on the menu that pops up. Then click on “Desktop (Create Shortcut)”.  The shortcut will then appear on the desktop.  
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Deleting a shortcut is as simple as clicking on the shortcut to select it then pressing the delete key on the keyboard.  This will bring up a message reminding you that deleting the shortcut will not remove the program – only the shortcut icon. Clicking “Delete Shortcut” will send it to the recycle bin.
Task: 

Create a shortcut to one of the files you created earlier (i.e. “letter.doc”) and then delete it.

Desktop
One of the many things people like to do with their computer is to make it a little personal. The simplest way to do this is to change the picture that displays on the computer desktop. 
Right clicking on any blank (no shortcut icon) space on the desktop will open the right mouse menu.  Click on “Properties” to open the “Display Properties”.

Now click the “Desktop” tab to access the desktop background picture controls.


There are a range of pictures already available which you can choose by simply clicking on them then clicking the OK button.  When you click on them a preview will appear in the little monitor.  If you want your own picture on the desktop you need to click the browse button, this will allow you to locate a picture anywhere in the computer and select it as your desktop picture.
Once selected you can choose from three display formats in the “Position” box.
Once you have chosen a picture, clicking OK will lock it in as your desktop picture – until you decide to change it again!

Task:
Access the Internet and do a Google image search to locate an appropriate picture for the desktop.  Save the picture, then access the display properties as described above and set the downloaded picture as the new desktop background.

Installing Software

From time to time you will want to install software on your computer – this may be driver software to make a new piece of computer hardware work or it may be new application software.  This is really quite a simple task – generally it involves little more than clicking “Next” buttons!

Software however can come in couple of forms.  It may be on a CD, in which case it will mostly come up with an option screen shortly after the CD is inserted. The design of this screen may vary greatly, but you should find a clickable “Install” link somewhere on it to start the installation process.

Alternatively you may download the software from the Internet.  This is an increasingly common way for software to be distributed.  In many cases it will also be free of charge – you can usually find software somewhere on the Internet to do just about anything you want to do that is legitimately free!  This kind of software is often called “freeware.”  Another common form on the Internet is “shareware.”  Shareware is free to download and try, but after a trial period – may be 14 or 30 days – it ceases to function, and you must either pay for it or uninstall it.  Of course there is also some software on the Internet which you most pay for up front.
Installing software of the Internet involves 2 main steps. The first is “downloading” it to the computer you are using. Downloading it means finding a clickable link that says something like “Download”, than saving it as a file on the computer when prompted. Usually the simplest place to do this is the desktop – because this is easily accessed in the next step.

The second step is going to the file you have saved, double clicking it to run it, than following the prompts to install the software.  Once you have completed the installation you can either delete or move the original file you downloaded as this is no longer required.  Generally it isn’t advised to make any significant changes to the settings on the install screens unless you know what you are doing!  The best way to learn this process is to do it! 
Task:

Open Internet Explorer and go to www.ccleaner.com.  Click on the “Download” link. 




This will load the download page as below, choose one of the download links and click it. 
This will switch you another page which has the message that the download should start automatically.  A message is likely to pop up after a few moments asking if you noticed the information bar…
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The information bar is found just below the address bar.  Clicking on this bar will give you a short menu with a “Download File” option. Click on this option.  You are probably wondering what this is all about.  The purpose of it is to stop the downloading of software that you didn’t ask for and which may be a security risk.
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Another security warning will appear asking you what you want to do with this file.  You could run it, but if something went wrong during the install process you would have to download it all over again.  The best option is to save – click “save”.
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The “Save As” box will appear.  Save to the Desktop, take note of the file name – you need to be able to locate this file again!
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Another box will appear showing the download progress, then telling you it is complete.  The time it takes will depend on the speed of the Internet connection. Again you could “Run” the file to begin installation, but the safer procedure is to “Close” and then locate the file and Virus check it before running it.  Click “Close”.
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You should now close all open windows including Internet Explorer.  This will give you a view of your desktop, on it you should be able to locate the file you just downloaded.  This is the CCleaner software in “packaged” form.  Before running it we will scan it to ensure that it isn’t virus infected.

Right click the file, than click “Scan for Viruses”.  The virus scanner will then run and should come back with a message that no risks or viruses have been found.  The exact nature of the process will vary according the specific anti-virus software you have installed.  Close the scanner when complete.
Now you can begin the installation process.  Double click the file, the following security message will appear, click “Run”.
You will now be asked to choose a language – click OK to English, unless you have other preferences.
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You will then go past the welcome screen – just click “Next”!

Than you will come to the license agreement – you must agree to install the software – click “I Agree”.  I don’t think anyone actually reads these agreements!
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The next screen simple asks where you would like the program installed.  Just leave these as is and click “Next”.

You will then see a progress bar go across the screen while it installs, when this is completed a screen will come up telling you that it is completed.  Click “Finish” on this to complete the process.

[image: image29.png]X

't CCleaner v1.32 Setup.

Choose Install Lacation =
Chaase the folder in which to nstal CCleaner v1.32. 6

Setup wilnstall CClsaner v1.52 in th following Folder. To install i a different folder, cick
Erawse and select another Folder. Cick Next t cantinte.

Destination Folder

Space requred: 2.8M8
Space available: 29.368




   [image: image30.png]% CCleaner v1.32 Setup

Completing the CCleaner v1.32
Setup Wizard

CCleaner v1.32 has been fnstalled on your computer.

Click Finsh ta close ths wizard,





Uninstalling Software

It is a good idea to remove unwanted software as it simply wastes disk space.  Occasionally you may also need to remove software because it is causing problems with your computer.

Some software is easy to uninstall, simply by going to the program listing under Start>All Programs and clicking the uninstall link and then following the prompts.
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But not all programs have this link, many have to be removed by accessing Start > Control Panel > Add/Remove Programs.  The appearance of the Add/Remove Programs link can vary according to computer configuration. So you may need to search a little.  The route will either be: Start > Control Panel > Add/Remove Programs or Start > Settings >Control Panel > Add/Remove Programs.
Once you have opened Add/Remove Programs, things are fairly simple.  It will have a list of all the software installed on the computer.  Scroll down this list, than click the program you wish to uninstall. Once highlighted, a “Change/Remove” button will appear.  Clicking this will begin the uninstall process.  Simply follow the prompts as you did with the install process.

It is a good idea to re-start the computer if prompted to do so after either (or both) the install and uninstall processes.
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Task:


Use Add/Remove Programs to uninstall CCleaner.  
You have now completed this course in basic computing.  There are many things still to learn, but if you remember that computers don’t have brains and are really just stupid machines you will have fun!
Wynyard Online Access Centre

21 Saunders Street
Wynyard Tas 7325
Email - wynyard@tco.asn.au
Website: http://wynyard.tco.asn.au 

Phone/Fax (03) 6442 4499
Floppy Disk Drive





CD Drive





Speakers





Computer (Hard Drive, CPU & Motherboard)





Monitor





Keyboard





Mouse





Shortcut Icons


Double click on these to open or run them.





Start Menu


Access Programs, Control Panel,


etc. from here.


Also Shut Down and Log Off.





Desktop


Picture





Start Button  Click here to open the Start Menu





Taskbar


Shows running programs and open Windows





Notification Area


Shows programs that run in the background and system notices – also the Time and Volume Control





Mouse Pointer








Program or 


Window Name





Menus





Control buttons





Scroll Bar


Move this to see more on screen.





Top Bar


Clicking and dragging (hold button down) will allow you to move the window.





Window Edge


Placing the mouse here will allow you to resize the window





Page Title





Window control buttons





“Go” Button





Forward/ Back icon





Toolbar





Address Bar





Page Menu


(Hyperlinks)


Part of open page








Open


Webpage





Scrollbar





Progress & Information bar





Hyperlinks





This is where you must type the word you want to search for. Click here first if cursor isn’t already flashing.





Clicking here will change your search to images or news





Click in the option button to choose if you want to search the whole world or only Australia





Click the Search button to activate the search or press the “Enter” key on keyboard





It’s ready for you to search again – click to enter a new search word.





Number of pages searched





Actual results – click hyperlink to view website.





These are paid listings – advertisements!!





Click down arrow for list.





Required





This is your username, the first part of your address. It can be anything you want - that is available!





Click this button after entering the desired username to see if it’s available.





Enter the same password twice.





Click this to remove the tick!





Click her to get a list of questions – choose a simple one.





Enter the answer to the question you chose here.





Ignore this box!





Enter the strange word into this box!  This is just to make sure you are human and not a computer!





Click this button to complete the application





Your email address





Click here to sign out





Click here to send an email





Introductory Emails from Gmail. Click anywhere on them to view them.





Blue highlight shows you which mail box you are currently in





Enter the email address of the person you wish to send the message to here.





Enter a subject for the message here.





Click “Send” when complete.





Type your message here.





Click here to attach a file





Paper clip indicates this message has an attachment





Gives you immediate access to this file





Allows you to save file to your computer





Click here to reply to sender





Click here to send this email on to another person,





Email address is entered automatically.





Type your reply here.





The original message has been quoted automatically.





Click here to send the reply.





Click here to archive your message





Click here to delete it forever!





Click here to sign out.





Click here to mark messages you wish to apply this action to.  Do this first!





Click here to Star a message.





Drive designation:





�  (A:)  	3 ½ inch Floppy Disk Drive. Uses removable floppy disks.  Only stores 1.44mb of data.  Now obsolete, but still found in most computers.


�  (C:)  	(Often called “Local Disk) Hard drive, with Windows XP, Programs and Documents on it.  Found in ALL computers.  Storage capacity can be 20-250GB.


� (D:) or (E:)	CD or DVD drive.  This includes CD-ROM drives which will only read data, and CD & DVD Writers which will both read and save data.  CD’s have a capacity of 700mb, DVD’s 4.7 GB.


� (Any Letter:) 	Removable drive (Flash drive or card). This includes USB “thumb” or “flash” drives.  Very versatile storage of data, but limited capacity (62mb – 4Gb).


� (Any Letter:) 	Network Drive (Located on another computer). This only exists if your computer is connected to a network (as we are here at Penguin OAC). 











Standard Toolbar


Open, Save, Print, Copy, Paste, etc.





Formatting Toolbar


Controls appearance & alignment of text.





Menu Bar





Document Name





Quick Start Bar


Click “X” to close.





Scroll bars





Status Bar





Cursor


Point at which text is entered.





Rulers





Document





Click here to display other menu items





If “Save in” folder isn’t already “My Documents” click button to move there.





Once in “My Documents” locate and double click the folder with your name.





Type a name for the letter, then click “Save”





Click the file “letter” once than click “Open”.  Alternatively you may double click “letter”.





Click this down arrow to change the text font.





Click here to change the size of the text





These 3 buttons will give you Bold, Italic and Underlined text





These 4 control the text alignment: left, centre, right & Justify





These 2 will give you numbered & bulleted lists





This button & drop down arrow allow you to change the text colour.





Press “Enter” here.





Press “Enter” here.





Click here
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